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End User Migration Instructions 
INTUIT QUICKEN (WINDOWS/MAC) / QUICKBOOKS 

 
 
As County Bank completes a system migration; you will need to modify certain 
information in your Quicken/QuickBooks software to ensure a smooth transition of your 
data. You must complete the following steps after the conversion date: January 25, 2007.  
 
It is important that you perform the following instructions exactly as described and in the 
order presented. If you do not, your PFM Banking service may stop functioning properly. 
 
If you have any questions regarding these instructions, please contact the Internet Branch 
at 800-322-8233. An Internet Branch representative will be available to assist you from 
9:00 a.m. to 5:00 p.m. Monday thru Friday and 9:00 a.m. to 12 p.m. Saturday.  You may 
also visit our website at www.countrybank.com 
 
 
Select your software version from this index to access instructions for your 
online accounts within Quicken (WIN/MAC) / QUICKBOOKS. 
 
 

Quicken Windows 2007
Quicken Windows 2004-2006

Quicken MAC 2007
Quicken MAC 2005-2006

Quicken MAC 2004
QuickBooks 2006 - 2007
QuickBooks 2005 - 2004

 
 



 
 

Intuit/Digital Insight   
End User Migration Instructions    
Quicken (WIN/MAC) / QUICKBOOKS  
 2 

Quicken Windows 2007 Instructions 
 
 

STEP A.  INSTALL THE LATEST QUICKEN UPDATE 

 
Follow the steps in this section to determine if a Quicken update is available 
and to download the update. 
 

1. From the Quicken Online menu, choose One Step Update. 
2. Uncheck all options in the One Step Update dialog boxes and click Update 

Now. 
3. If an update is available, apply it now. 
4. Exit and restart Quicken. 

 
For more information, see http://www.intuit.com/support/quicken/updates/. 
 
 

 

STEP B.  BACK UP YOUR CURRENT QUICKEN DATA 

 
From the Quicken File menu, choose Backup, enter information, as needed in 
the Quicken Backup dialog boxes, and then click OK.   
 
Do not restore to any earlier backups after you complete these instructions. 
 
 

STEP C.  DEACTIVATE YOUR ACCOUNTS 

 
 

1. Open the register for the first account at County Bank Savings. 
2. Click the Overview tab. 
3. Before you continue, it is important that you record your account information. 

From this window you will see your Account Number, Routing Number, and 
Customer ID.  Write this information down so you have it later, or choose 
File, Print Overview. 

4. In the Account Attributes area, click Change Online Services. 
5. Click Remove from One Step Update in the One Step Update. 
6. Click Yes when the “Would you like to deactivate this service?” message 

appears 
7. Click Yes to continue and then OK 
8. Repeat steps 1-7 for all accounts enabled for online access. 
9. To ensure all online accounts have been disabled, go to the Tools menu, 

Account List and verify the word ‘Activated’ does not appear in the Online 
Services column for all your County Bank Savings accounts.  Close this screen 
by clicking the ‘X’ on the top right corner of this page. 

 
 

http://www.intuit.com/support/quicken/updates
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STEP D.  REACTIVATE YOUR ACCOUNT(S) 

 
 

1. Open the register for the first account at County Bank Savings 
2. Click the Overview tab 
3. In the account attributes area, click Change Online Services. 
4. Click the Online Services tab. 
5. To activate Transaction Download, click Activate One Step Update in the One 

Step Update area.  
6. Enter the Direct Connect User ID and PIN and click Next. Follow the 

instructions to match the existing account and add new accounts, as applicable. 
7. Repeat steps 1-6 until all County Bank Savings accounts have been activated. 

 

If you use the Quicken PIN Vault, update it now.  
If you use the Quicken PIN Vault, you will need to re-add your PIN for County 
Bank for Savings. 
 

1. From the Quicken Online menu, choose Password Vault and then choose 
Edit. 

2. In the PIN Vault Password dialog box, enter your PIN Vault Password and then 
click OK. 

3. Select the User ID at County Bank for Savings and click Add Password 
4. In the “Add a Password” dialog box, enter your County Bank for Savings PIN, 

re-enter your County Bank for Savings PIN, and then click Add. 
5. Click Done. 

 
 

 

STEP E.  GO ONLINE 

 
 

1. From the Quicken Online menu, choose Online Center.  
2. In the Online Center window, click Update/Send.  
3. Click Update Now to continue and then wait until your online session is 

completed 
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Quicken Windows 2004 - 2006 Instructions 
 
 

STEP A.  INSTALL THE LATEST QUICKEN UPDATE 

 
Follow the steps in this section to determine if a Quicken update is available 
and to download the update. 
 

1. From the Quicken Online menu, choose One Step Update. 
2. Uncheck all options in the One Step Update dialog boxes and click Update 

Now. 
3. If an update is available, apply it now. 
4. Exit and restart Quicken. 

 
For more information, see http://www.intuit.com/support/quicken/updates/. 
 
 

 

STEP B.  BACK UP YOUR CURRENT QUICKEN DATA 

 
From the Quicken File menu, choose Backup, enter information, as needed in 
the Quicken Backup dialog boxes, and then click OK.   
 
Do not restore to any earlier backups after you complete these instructions. 
 
 

STEP C.  DEACTIVATE YOUR ACCOUNTS 

 
 

1. Open the register for the first account at County Bank Savings. 
2. Click the Overview tab. 
3. Before you continue, it is important that you record your account information. 

From this window you will see your Account Number, Routing Number, and 
Customer ID.  Write this information down so you have it later, or choose 
File, Print Overview (2006/2005) or Print Page (2004). 

4. In the Account Attributes area, click Change Online Services. 
5. Click Deactivate in the Transaction Download area and then click Yes in the 

pop-up dialog box to confirm. 
You will receive the message: “You are about to delete setup information for an 
online account.”  Click OK.  Click OK again. 

6. Repeat steps 1-5 for all accounts enabled for online access. 
7. To ensure all online accounts have been disabled, go to the Tools menu, 

Account List and verify the word ‘Activated’ does not appear in the Online 
Services column for all your County Bank Savings accounts.  Close this screen 
by clicking the ‘X’ on the top right corner of this page. 

 
 

http://www.intuit.com/support/quicken/updates
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STEP D.  REACTIVATE YOUR ACCOUNT(S) 

 
 

1. Open the register for the first account at County Bank Savings 
2. Click the Overview tab 
3. In the account attributes area, click Edit Account Details. 
4. Click the Online Services tab. 
5. To activate Transaction Download, click Activate in the Transaction Download 

area. Enter the Direct Connect User ID and PIN and click Next. Follow the in-
screen instructions to match the existing account and add new accounts, as 
applicable. 

6. Repeat steps 1-5 until all County Bank Savings accounts have been activated. 
 

If you use the Quicken PIN Vault, update it now.  
If you use the Quicken PIN Vault, you will need to re-add your PIN for County 
Bank for Savings. 
 

1. From the Quicken Online menu, choose PIN Vault and then choose Edit. 
2. In the PIN Vault Password dialog box, enter your PIN Vault Password and then 

click OK. 
3. Select your first account at County Bank for Savings by clicking the account 

number.  
4. Click Add PIN. 
5. In the Change A PIN dialog box, enter your County Bank for Savings PIN, re-

enter your County Bank for Savings PIN, and then click Add. 
6. Click Done. 
7. Repeat steps 3 – 6 for each account at County Bank for Savings 

 
 

 

STEP E.  GO ONLINE 

 
 

1. From the Quicken Cash Flow menu, choose Online Center.  
2. In the Online Center window, click Update/Send.  
3. Click Update Now to continue and then wait until your online session is 

completed 
 
 



 
 

Intuit/Digital Insight   
End User Migration Instructions    
Quicken (WIN/MAC) / QUICKBOOKS  
 6 

Quicken MAC 2007 Instructions 
 

 

STEP A  INSTALL THE LATEST QUICKEN 2007 UPDATE 

 
1. From the Quicken 2007 menu, choose Check for Updates. 
2. If an update is available, you will be prompted to go to 

http://www.intuit.com/support/quicken/updates and follow the instructions to 
update to the latest version of Quicken.  

3. Quit and restart Quicken. 
  

STEP B  BACK UP YOUR CURRENT QUICKEN DATA 

 
From the File menu, choose Save a Copy, and then click OK.   

 

STEP C  DEACTIVATE YOUR ACCOUNTS  

Note: All transactions must be accepted in the account register before 
accounts can be deactivated.  

 
1. From the Lists menu, select Accounts. 
2. Select the account you want to disable and click Edit. This will open the Edit 

Account sheet.  
3. In the Download transactions dropdown menu, select not enabled. You will 

receive the message: “You are about to disable online services for this account 
within Quicken.”  Click OK.  

4. To save these changes click OK at the bottom of the Edit Account sheet.  
5. Repeat steps 1-4 for all accounts you have enabled for online access. 
6. To ensure all your online accounts have been disabled, go to the Lists menu, 

select Accounts and verify the blue globe does not appear next to any of your 
accounts.   

7. Close and reopen Quicken MAC. 
 
 

STEP D  
REACTIVATE YOUR ACCOUNTS 

 

 
1. From the Lists menu, select Accounts. 
2. Select the account you just disabled and click Edit. This will open the Edit 

Account sheet. 
3. Select using direct connect in the Download transactions dropdown menu.  
4. Click OK to save your changes to this account.  
5. Repeat steps 1-6 for every account.   

 

http://www.intuit.com/support/quicken/updates
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If you use the Quicken PIN Vault, you will need to update your County 
Bank for Savings PIN. 
 

1. From the Quicken Online menu, choose PIN Vault. 
2. In the PIN Vault tab, select County Bank for Savings and click Edit.  
3. In the Change PIN sheet, enter your County Bank for Savings PIN, and re-enter 

your County Bank for Savings PIN, and then click OK. 
 
 
 

STEP E  GO ONLINE 

 
 

1. From the Quicken Online menu, choose One Step Update 
2. Click on Enter PIN.  
3. Enter the Direct Connect PIN and click OK and then Update Now 
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Quicken MAC 2005-2006 Instructions 
 

 

STEP A  INSTALL THE LATEST QUICKEN 2005/2006 UPDATE 

 
1. From the Quicken 2005/2006 menu, choose Check for Updates. 
2. If an update is available, you will be prompted to go to 

http://www.intuit.com/support/quicken/updates and follow the instructions to 
update to the latest version of Quicken.  

3. Quit and restart Quicken. 
  

STEP B  BACK UP YOUR CURRENT QUICKEN DATA 

 
From the File menu, choose Save a Copy, and then click OK.   

 

STEP C  DEACTIVATE YOUR ACCOUNTS  

Note: All transactions must be accepted in the account register before 
accounts can be deactivated.  

 
1. From the Lists menu, select Accounts. 
2. Select the account you want to disable and click Edit. This will open the Edit 

Account sheet.  
3. In the Download transactions popup, select not enabled. You will receive 

the message: “You are about to disable online services for this account within 
Quicken.”  Click OK.  

4. To save these changes click OK at the bottom of the Edit Account sheet.  
5. Repeat steps 1-4 for all accounts you have enabled for online access. 
6. To ensure all your online accounts have been disabled, go to the Lists menu, 

select Accounts and verify the blue globe does not appear next to any of your 
accounts.   

7. Close and reopen Quicken MAC. 
 
 

STEP D  
REACTIVATE YOUR ACCOUNTS 

 

 
1. From the Lists menu, select Accounts. 
2. Select the account you just disabled and click Edit. This will open the Edit 

Account sheet. 
3. Select using direct connect in the Download transactions dropdown menu.  
4. Click OK to save your changes to this account.  
5. Repeat steps 1-6 for every account.   

 

http://www.intuit.com/support/quicken/updates
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If you use the Quicken PIN Vault, you will need to update your County 
Bank for Savings PIN. 
 

1. From the Quicken Online menu, choose PIN Vault. 
2. In the PIN Vault tab, select County Bank for Savings and click Edit.  
3. In the Change PIN sheet, enter your County Bank for Savings PIN, and re-enter 

your County Bank for Savings PIN, and then click OK. 
 
 
 

STEP E  GO ONLINE 

 
 

1. From the Quicken Online menu, choose Download Transactions. Make sure that 
County Bank for Savings is selected from the Financial Institution popup. 

2. Click Download and enter your Direct Connect PIN when prompted.  
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Quicken MAC 2004 Instructions 
 

STEP A.  INSTALL THE LATEST QUICKEN® 2004 UPDATE 

 
From the File menu choose Check for Updates.  If there is an update 
available, you will be prompted to go to 
http://www.intuit.com/support/quicken/updates and follow the step-by-step 
instructions to update to the latest version of Quicken 2004. 
 

 

STEP B.  BACK UP YOUR CURRENT QUICKEN DATA 

 
Quicken MAC software comes preset to download your data file every time the 
software is closed. When you choose Quit from the File menu, Quicken 
automatically saves a backup copy of your current data file and puts it in the 
folder if your choice.   
 
To access the backup folder Go to the File drop down menu and click  
Open Backup. 
 
To change a backup settings using OS X: 
1. Choose Preferences from the Quicken menu 
2. Scroll down the list of preferences on the left until you see Security; Select 
the File Backup option. 
3. Click Automatically backup my data file when closing to select or clear 
check box, as appropriate 
4. To change the folder where the backup copy is saved, click Choose 
5. Click OK. 
 
NOTE: To change a backup setting using OS 9.x choose preferences from 
Quicken Edit menu. 
 
 

STEP C.  DEACTIVATE YOUR ACCOUNTS 

 
All transactions must be accepted in the account register before accounts can 
be deactivated.  
 

1. From the Lists menu, select Accounts. 
2. Select the first account at County Bank for Savings and click Edit. 
3. Click the Edit Online Access button.  
4. Quicken will connect to the Internet and update the information it has about 

your financial institution. Note: if you are on a dialup connection this may take 
a few minutes. 

5. Once the information is updated, the Account review panel of the Quicken 
Assistant will open. Write down the account number and routing number. It will 
be needed to reconnect the account.  
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6. On the Account review panel click the Direct connect link to the right of 
Statement download. Quicken automatically opens the Choose Services panel 
of the Assistant. Deselect the Download statements. 

7. Quicken displays a warning “You are about to delete setup information….” 
8. Click OK and then the Return to Review button in the lower left.  
9. Click Continue and then Done. 
10. Repeat steps 2 – 9 until all County Bank for Savings accounts have been 

disabled. 
 

 

STEP D.  REACTIVATE YOUR ACCOUNT(S) 

 
1. From the Lists menu, select Accounts. 
2. Select the account you want to re-enable for online services and click Edit. 
3. Click the Enable Online Access button. This will open the Set up Online 

Services Assistant. 
4. Click Continue. 
5. Select the appropriate account from the pop-up menu and click Continue. 
6. Scroll down the list to County Bank for Savings. Select County Bank for Savings 

and click Continue.  
7. Quicken will connect to the Internet and update the information it has about 

your financial institution. Select the online services you would like to use and 
click Continue.  

8. Quicken will ask if you have received your customer ID and PIN. Click Yes and 
then Continue. 

9. Enter your Customer ID, Routing number, and Account number and click 
Continue. 

10. Review your online account information and click Continue and then Done.   
11. Repeat steps 2 – 10 for each account at County Bank for Savings. 

 
 
 

 

STEP E.  GO ONLINE 

 
1. From the Online menu select Download Transactions. 
2. Select County Bank for Savings and click Get Online Data. Quicken will 

retrieve the latest transactions for all accounts enabled for online services with 
County Bank for Savings 

3. Enter the PIN.  
4. Click OK to get your data. 
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QuickBooks 2006-2007 Instructions 
 

 

STEP A.  INSTALL THE QUICKBOOKS UPDATE 

 
1. From the Help menu, select Update QuickBooks. 
2. Select Update Now and then Get Updates 

 
 

STEP B.  BACKUP YOUR CURRENT QUICKBOOKS DATA 

 
From the QuickBooks menu, choose File, Backup, and enter a new backup 
filename. 
 

 

STEP C.  DEACTIVATE YOUR ACCOUNTS 

Note: All transactions must be added to the account register before 
deactivating accounts. 

 
1. From the List menu select Chart of Accounts. 
2. Select a County Bank for Savings online account.  Click the Account button, 

Select Edit Account. 
3. The Edit Account dialog box appears.  Click Online Info tab. 
4. Write down the ROUTING NUMBER, ACCOUNT NUMBER, ACCOUNT TYPE, and 

CUSTOMER ID.  You will need this in a later step. 
5. QuickBooks displays the Online Info window.  Deselect Online Account 

Access.  Click OK. 
6. QuickBooks displays a warning message informing you that you are about to 

delete online setup information for a QuickBooks online account.  Click OK  
7. If QuickBooks displays a warning message asking you if you want to retain the 

online information associated with this account.  Click NO.   
8. Repeat steps 1 through 8 until all County Bank for Savings Accounts have been 

disabled. 
9. CLOSE and REOPEN QuickBooks. 
 

 
 

STEP D.  REACTIVATE YOUR ACCOUNT(S) 

 
 

1. From the Banking menu, select Online Banking, and then Online 
Banking Center  

2. At the prompt to set up accounts for online services, select Yes 
3. Click Yes to continue 
4. Click Enable Accounts tab.  Click Next.  Click Add Financial Institution 

button.  
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5. Select County Bank for Savings. Click the Done button and then OK.  
6. Click the dropdown arrow to the right of I would like to enter 

information for my accounts. 
7. Select County Bank for Savings.  Click Next. 
8. Select Yes I have my confirmation letter from County Bank for Savings. 

Click Next. 
9. Enter the Routing Number.  
10. Enter your Customer ID.   
11. Click Next.  Click the dropdown arrow to the right of Use my existing 

QuickBooks account. Select your QuickBooks online Account.  Click Next.   
12. Click the dropdown arrow to the right of County Bank for Savings Account 

Type. 
13. Select the correct account type for this account.   
14. Type your County Bank for Savings account number into the Account 

Number. 
15. Select online account access and click Next. 
16. Review the account information. 
17. If you have more accounts to enable, select Yes next to Do you wish to 

enable additional accounts? Click Next and repeat these steps until all 
County Bank for Savings Accounts have been enabled. 

18. If you do not have more accounts to enable, select No next to “Do you wish 
to enable additional accounts?”  Click Next. 

19. QuickBooks displays the Service Agreement.  Click OK. 
20. QuickBooks asks if you wish to enable accounts at another institution. 
21. Select No.  Click Next. 
22. QuickBooks displays a Congratulations screen.  Click Leave. 

 
 
 

STEP E.  GO ONLINE 

 
 

1. From the Banking menu, select Online Banking, and then Online 
Banking Center.   

2. The Online Banking Center appears.  Click Go Online.  Enter your PIN and 
click OK. 
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QuickBooks 2005 - 2004 Instructions 
 

 

STEP A.  INSTALL THE QUICKBOOKS UPDATE 

 
From the QuickBooks menu, choose File, Update QuickBooks. Follow update 
instructions. 
 
 

STEP B.  BACKUP YOUR CURRENT QUICKBOOKS DATA 

 
Back up your current QuickBooks data. From the QuickBooks menu, choose 
File, Backup, and enter a new backup filename. 
 

 

STEP C.  DEACTIVATE YOUR ACCOUNTS 

Note: All transactions must be added to the account register before 
deactivating accounts. 

 
1. Select Chart of Accounts from the List menu. 
2. Select a County Bank for Savings online account.  Click the Account button, 

Select Edit. 
3. The Edit Account dialog box appears.  Click Online Info tab. 
4. Write down the ROUTING NUMBER, ACCOUNT NUMBER, ACCOUNT TYPE, and 

CUSTOMER ID.  You will need this in a later step. 
5. QuickBooks displays the Online Info window.  Deselect Online Account 

Access.  Click OK. 
6. QuickBooks displays a warning message informing you that you are about to 

delete online setup information for a QuickBooks online account.  Click OK  
7. If QuickBooks displays a warning message asking you if you want to retain the 

online information associated with this account.  Click NO.   
8. CLOSE and REOPEN QuickBooks. 
9. Repeat steps 1 through 8 until all County Bank for Savings Accounts have been 

disabled. 
 

 
 

STEP D.  REACTIVATE YOUR ACCOUNT(S) 

 
 

1. Select Set Up Online Financial Services from the Banking menu. 
2. Select Set Up Account for Online Access.  Click Enable Accounts tab.  Click 

Next.  Click Add Financial Institution button.  
3. Select County Bank for Savings. Click the Done button and then OK. Click Add 

to QuickBooks button. Click Exit on the Browser bar. Click the dropdown 
arrow to the right of I would like to enter information for my accounts. 
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4. Select County Bank for Savings.  Click Next. 
5. Select Yes I have my confirmation letter from County Bank for Savings. 

Click Next. 
6. Enter the Routing Number.  
7. Enter your Customer ID.   
8. Click Next.  Click the dropdown arrow to the right of Use my existing 

QuickBooks account. 
9. Select your QuickBooks online Account.  Click Next.  Click the dropdown arrow 

to the right of County Bank for Savings Account Type. 
10. Select the correct account type for this account.  Type your County Bank for 

Savings account number into the Account Number. 
11. Select online account access and click Next. 
12. Review the account information. 
13. If you have more accounts to enable, select Yes next to Do you wish to 

enable additional accounts? Click Next and repeat these steps until all 
County Bank for Savings Accounts have been enabled. 

14. If you do not have more accounts to enable, select No next to “Do you wish to 
enable additional accounts?”  Click Next. 

15. QuickBooks displays the Service Agreement.  Click OK. 
16. QuickBooks asks if you wish to enable accounts at another institution. 
17. Select No.  Click Next. 
18. QuickBooks displays a Congratulations screen.  Click Leave. 

 
 
 

STEP E.  GO ONLINE 

 
 

1. From the Banking menu, select Online Banking Center  
2. The Online Banking Center appears.  Click Go Online.  Enter your PIN and click 

OK. 
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